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Safety Guidelines

This manual contains notices intended to ensure personal safety, as well as to protect the products and

connected equipment against damage. These notices are highlighted by the symbols shown below and

graded according to severity by the following texts:

! Danger
indicates that death, severe personal injury or substantial property damage will result if proper
precautions are not taken.

! Warning
indicates that death, severe personal injury or substantial property damage can result if proper
precautions are not taken.

! Caution
indicates that minor personal injury can result if proper precautions are not taken.

Caution
indicates that property damage can result if proper precautions are not taken.

Notice
draws your attention to particularly important information on the product, handling the product, or to a
particular part of the documentation.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are

defined as persons who are authorized to commission, to ground and to tag circuits, equipment, and

systems in accordance with established safety practices and standards.

Correct Usage

Note the following:

!
Warning
This device and its components may only be used for the applications described in the catalog or the

technical description, and only in connection with devices or components from other manufacturers

which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed
correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.

Third parties using for their own purposes any other names in this document which refer to trademarks might

infringe upon the rights of the trademark owners.
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1 DOCPRO facts

1.1 Introduction

After you have created a system (project), you need to organize the documentation
of your project data. An appropriate documentation structure makes it easier to edit
and service the project.

Management and printing

The DOCPRO tool helps you to efficiently create and manage your system
documentation. It enables you to apply any structure to your project data, process
them in the shape of standardized wiring manuals and print them with a uniform
image.

DOCPRO enables centralized control of print processes. You directly aim project
parts or the complete data of your project for output on the printer.

DOCPRO directly accesses current project data for printing. This means that your
documentation is always up-to-date.

Layout design

You also have the option of deigning a user-specific page layout, for example, for
compliance with DIN 6771 standard on templates for technical documentation or if
you want to take your company rules into consideration.

DOCPRO supports all phases of documentation, offering comfortable options of
adapting the image to your individual requirements.
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1.2 Performance features of DOCPRO

DOCPRO offers various functions helping you to create your documentation in an
easy way:

• Creation and management of technical documentation compliant with
standards

• Use of included layout templates in various formats and languages

• Implementation of cover sheets

• Automatic creation of document directories

• Automatic and manual assignment of drawing numbers

• Import of user-defined layouts and cover sheets

• Layout modification by filed replacement or modification

• Export and import of footer data for quick editing

• Implementation of any graphics in layouts, e. g. your company logo

• Centralized footer editing and management

• Comfortable print management

• Printing to file with unique name assignment and saving to a directory of your
choice

1.3 Which data is included in the documentation?

Your documentation can include all data you have generated with the help of a
configuration tool. Data are therefore available in a clear structure and can be
centrally managed and printed.

For example, your documentation can include the following data:

• Blocks (program code, generated with LAD, FBD, STL etc.)

• Symbol tables containing the symbolic names of absolute addresses

• Reference data such as cross-reference lists, wiring diagrams, program
structure

• Hardware configuration tables showing the arrangement of your PLC modules
and module parameters

• Variable tables showing status formats as well as status/control values

• Global data tables

• Link tables

• CFC and SFC diagrams

Note
Depending on your STEP 7 or PCS 7 version you may find that it is not possible to
document all project data in DOCPRO.
You create a print object by entering an object in a documentation. DOCPRO
does not save the object in its own data structure, but rather calls it directly from
the respective application when you print it. This means that your hardcopy always
contains up-to-date data.
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2 General notes on operating DOCPRO

2.1 The DOCPRO user interface

The DOCPRO user window consists of two sections, namely the directory window
and the detail window.

In the left section of the DOCPRO user window you see the directory window
containing the hierarchy of the document structure. In the right section of the
DOCPRO user window you see detail information on the object you have
highlighted in the directory window.

2.2 Adaptation of the user interface

You have the following options of adapting the user window to your requirements.
You can

• modify the arrangement of the user interface using your mouse by dragging the
separating line between the directory/detail window into the desired position.

• hide or show the statusbar and the toolbar via "View > Statusbar" or "View >
Toolbar".

• adapt the width of the columns in your detail window by shifting the separating
lines to the desired position.
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3 Creating documentations in DOCPRO

3.1 Documentation facts

DOCPRO is a highly flexible tool helping you to create a hierarchy structure of your
system documentation:

• The "Documentation" folder is assigned to the project. It contains all project
data.

• The "Documentation" folder can contain one or multiple wiring manuals.

• A wiring manual can be split into one or multiple job lists.

• Each job list contains one or multiple print objects. A job list can also contain
one or multiple cover sheets.

The hierarchical organization of your documentation with the help of theses
elements allows you to create a clearly arranged and extensive system
documentation. The arrangement of project data in your documentation
subsequently determines the order of your print queue.

Note

In SIMATIC Manager, all cross-references will be invalid if you copy an existing
project documentation into a new project. If you copy the entire project into a new
project and then copy the documentation, only the cross-references to the symbol
tables will become invalid.
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3.2 Creating documentations

You have several options of creating a documentation, depending on your specific
requirements. The table below helps you to select the most suitable method.

 If you…  … then

…rarely create a documentation and do
not require any special configuration,

… use the Wizard to generate a new wiring manual,
and simply accept the default values.

… frequently create documentation and
choose a customized configuration,

… generate a reference project in which you can
create your personal configuration. Once you have
created this global and special configuration in your
reference project, you can simple export it into any
new project.

• Global settings

• Print object type configuration

• Layout specification

• Footers

3.3 How to modify footers and layouts

DOCPRO also offers you various functions improving your work efficiency in
DOCPRO:

• time-saving modification of footer data

• preparation for optimized generation of PDF files

 If you…  … then

…want to effectively make more than
one setting in a single action,

… use the different functions for easy modification:

• Multiple selection when modifying print object
types – allows you to modify the setting for
multiple print objects in one go.

• Mass editing of footer data – allows you to export
existing data to a *.csv file, quickly edit it and
then reimport it.

… if you want to make special
modifications in your layout, so that you
can post-process your documentation
as a PDF file, e. g. index updates,

… if you want to edit your existing layouts in a
special way to make them suitable for post-
processing in Adobe Acrobat.
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3.4 Advantages of a reference project

A reference project does not contain real project data, but rather settings and
specifications which can be used for all other projects. These settings are made
once in your reference project. You can simplify your work in future projects by
applying these settings globally to all subsequent projects.

Configuration

You can customize your reference project as follows:

• Global footers

• Layouts you have created yourself and deleted layouts

Note

The special settings are not applied once you have modified the default layouts.

• Configuration of Print object types: Layout, Character number schemes, Views

• Deselected Print object types

• Sequence of Print object types

When a project containing real project data requires a special configuration other
than the one in the reference project, you can specifically edit this project. This
configuration does not influence the reference project.

3.5 Objects in DOCPRO

3.5.1 Overview of objects in DOCPRO

In DOCPRO we differentiate between various objects. The object…

• "Documentation" contains all project data, e. g. wiring manuals, job lists and
print objects.

• "Wiring Manual" can be split into multiple job lists in order to improve the
structure of your system documentation.

• "Job List" contains one or multiple print objects.

• Every job list can include a "Cover Sheet".

• The term "Print object type" represents a generic term for various print object
instances. It is not directly visible in the documentation structure.

• A "Print Job" consists of one or multiple print objects to be printed. A print job is
made visible when highlighted in the directory/detail window. A print job is not
static. Rather, it is a variable operation according to respective requirements.

19.12.2001



Creating documentations in DOCPRO

DOCPRO Creating Documentation
3-4 A5E00134750-01

3.5.2 Wiring Manuals

Depending on the scope of the project, a documentation can consist of one or
multiple wiring manuals. You can create any number of wiring manuals in your
project. The wiring manual, for example, summarizes data describing a self-
contained system unit.

Caution

You should always use the DOCPRO Wizard to create new wiring manuals. This
Wizard leads you step-by-step through the creation of a wiring manual. Important
settings are specified by default in order to prevent you from forgetting any entries.
Although manual configuration is possible, we do not recommend such steps.

Editing options

You can always modify or expand a wiring manual, for example,

• by adding further job lists,

• by inserting additional print objects,

• change the sequence of print objects in the job list or

• by modifying the print object properties.

Of course you can also modify your configuration of the print object types. In this
case, always ensure that this new configuration does not have any effect on the
print objects you have already inserted, but rather on print objects you insert after
having made your changes.

3.5.3 Job Lists

You can insert one or multiple job lists in a wiring manual, – irrespective of special
project structures –. This offers clear editing options.

For example, job lists can contain data describing specific control tasks. You can
also choose other order criteria by gathering frequently printed program sections in
a single job list.

The job list sequence corresponds with the print queue which you can modify at
any time.
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3.5.4 Print Objects

When using SIMATIC Manager, for example, to insert blocks or CFC diagrams in a
job list, you obtain so-called print objects. You can print these objects within a print
job.

You can insert any number of project objects into a job list. You can also insert a
print object in one or multiple job lists.

You can specify the following print object properties:

• Object-specific footer data – these data is unique throughout the object

• A specific layout

• Specifications relating to page numbering

• Specification of different views, e. g. you can display the symbols in different
order or with different filters.

You can specify and also modify the sequence of print objects at any time. Global
footer data is entered automatically if specific data is not available.

Selecting print objects

You can select print objects according to a structure you already know from
working with SIMATIC Manager: You can choose the component or the
technological view. Objects displayed in light-gray color cannot be printed.

You can directly insert print objects shown the selection window in a job list. To
select other objects you must select the parent folder.

Cover sheets

A cover sheet is a print object; the same as all other print objects. However, this
type of object is not part of the project in SIMATIC Manager.

To create a master cover sheet for your documentation, you first have to insert a
cover sheet as first print object in the job list. The layout you specify for a cover
sheet should match that of the other print objects.

3.5.5 Print object types

Print objects are allocated to different print object types, e. g. all specific CFC
diagrams belong to the print object type "CFC". In print object types you can
specify global settings such as layout or drawing number schemes. These settings
apply to all print object allocated to the respective print object type. Print object
types determine which objects are actually going to be printed.

3.5.6 Print jobs

In the directory window, you generate a print job when you select an object for
printing. For example, if you highlight the "Wiring Manual", object all job lists and
corresponding print objects contained in this manual are automatically printed.
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You can also select one or multiple print objects in the detail window to generate a
print job. In this case, all highlighted print objects are printed in the order of their
appearance in the directory window.

3.5.7 Editing objects

You have several options of subsequently editing objects in DOCPRO. These
different options depend on the type of object:

Editing objects

DOCPRO offers you the following options of editing "Wiring manuals" and "Job
lists":

• Rename

• Copy

• Move

• Delete

Editing print objects

You have the following options:

• Copy

• Move

• Delete

Note

In DOCPRO you cannot rename print objects. You can only do this in the
application you have used to create them, e. g. in SIMATIC Manager. When you
have renamed an object in the respective application, the new name is
automatically applied in DOCPRO.

Editing cover sheets

You have the following options:

• Rename

• Copy

• Move

• Delete
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3.6 Working in DOCPRO

3.6.1 Overview of the wizard for creating new wiring manuals

Click on "Insert > Wizard ’New wiring manual…'" to open the wizard. It involves
steps:

• Step 1 of 6: Introduction

• Step 2 of 6: Selection of the objects for your documentation

• Step 3 of 6: Specifying a layout and drawing number scheme for the various
object types

• Step 4 of 6: Specifying whether or not to print specific print object types and
their sequence in the print queue.

• Step 5 of 6: Input of global data for the documentation

• Step 6 of 6: Input of the name for the new wiring manual

A job list is automatically inserted when you insert a wiring manual.

In the wizard you can make many settings which you can then modify at any time.

3.6.2 Configuration overview

In DOCPRO you can customize various properties:

• Global configuration – applies to the complete project

• Configuration of Print object types – applies to all print objects which can be
assigned to this print object type.

• Object-specific configuration – applies to a specific object only

3.6.3 Global configuration

A global configuration applies to all print objects of the project. Page numbering
specification as well as footer data belong to this global configuration. Open the
"Global configuration" dialog via "Extras > Global configuration…" command

Object-specific settings for specific print objects are of a higher priority than global
footer data.

Global settings are made on different tabs.
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3.6.4 Print object type configuration

You can set specific properties for Print object types which are automatically
applied to print objects assigned to this print object type.

The following configuration is possible:

• Layout – You can select different layout. These layouts are named according
to a specific scheme.

• Drawing number scheme – Here you can specify the drawing number scheme
for the corresponding print objects.

• View 1 – You can specify a view for most print object types. In this view you
define the parameters showing a view from different angles or with different
information: In the variable table you can select different columns, e. g.
Symbol, Symbol value, Status value, Status. For CFC diagrams, for example,
you specify whether or not to print diagrams with diagram connections.

Note

The setting of print object types can be "overwritten" by object-specific settings
you make in the "Properties" dialog.

When generating a wiring manual with the help of the wizard, you can make these
settings in step 3.

3.6.5 Properties of print objects – object-specific

You can define object-specific footer data which apply only to the print object they
were actually defined for.

Global and object-specific configurations are made in one dialog. Global data is
defined in the "Global" column, object-specific data is defined in the "For this print
object" column.

Properties with multiple selection

If you have called the object properties for a group of objects, the dialog shows the
content of the print object first selected in the job list.

If you select print objects belonging to different print object types only the
properties common to all are displayed. The "View" tab is hidden.
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Configuration overview

The following configuration is possible:

• Footer data – you can make your entries in the property sheets 1 to 5 and
"Free Fields".

• Layout – You can specify an individual layout for any print object.

• Page numbering – here you can specify the page numbering scheme: Either
you number the pages consecutively or within the print object.

• View – Some applications display their data in different views. In DOCPRO you
can select the view for printing data.

Editing options

You have various options of specifying print object properties.

• Modification of a single print object

• Simultaneous modification of multiple print objects, using the multiple selection
function
Here you must select multiple print objects. Note that in this case the dialog
only shows properties common to all print objects. Also, the "View" tab is
hidden.

3.7 Further functions

3.7.1 Overview of further arrangements

DOCPRO also offers you other automatically generated arrangements providing
important information:

• Document directory – a listing of all documents belonging to a print job.

• Result log – diverse information generated after a print job has been carried
out or after an error has occurred when importing footers.

3.7.2 Document directory

The document directory lists all documents belonging to the respective print job.
The document directory of all print objects shows the following information:

• Cont. number

• Object name

• Symbolic name

• Project path
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• Drawing number

• Status

• Sheet

• Page

• Designation

Content

The corresponding document directory is printed, depending on the object you
have selected in the object hierarchy. For example, if you select a wiring manual,
the document directory of the complete wiring directory is printed. In contrast, only
the document directory of the corresponding job list is printed if you only select job
list.

Printing

In DOCPRO, the document directory is not a visible print object in the job list. You
can choose to print the document directory individually or together with a print job.
In this case it is the last object processed in a print job. Of course, in a print job you
can also disable the printout of the document directory.

Layout

You can specify the layout of a document directory in the print object type
"Document directory".

Footer data

Therefore, you cannot assign specific footer data to a document directory. Rather,
correspondingly defined global footer data is used.

3.7.3 Report

In a report you find messages, warnings and errors logged in following cases:

• during printing or

• when importing footer data

The following options are available for working with a report:

• Assigning a layout

• displaying

• printing
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4 Layout

4.1 Layout facts

Your layout defines, for example the format, alignment and arrangement of the
hardcopy. This layout also determines the arrangement of the footers.

You can assign a layout to the following objects:

• The print object types – here you define the default layout that applies to all
print objects allocated to the corresponding print object type. Before you insert
print objects in the job lists, you should adapt your default layout setting to that
of your print object types. This has the advantage that the correct layout is
assigned at the time you insert the objects.

• The print objects – here you assign a layout specifically and only to this print
object. If your documentation contains multiple instances of a print object or
cover sheet, you can select a different layout for each instance.

DOCPRO initially assigns a default layout to a print object or cover sheet you enter
in the job list. You can select another layout at any time if it does not conform with
your requirements. This might be required if you distribute your system on the
international market and want to adapt your documentation to different national
standards.

4.2 Available DOCPRO layouts

The DOCPRO scope of delivery includes layout for the following paper formats.
Documents created with these layouts conform with DIN 6771.

• DIN A3

• DIN A4

• Letter

• Legal

All layouts are available in portrait and landscape format, with or without binding
margin. Also, all layouts are available in five languages.

All layouts include a matching cover sheet layout.

The DOCPRO scope of delivery also includes special layouts for continuous page
numbering, giving you the option of printing your complete documentation with
continuous page numbers. These layouts are identified with the letter K at the fifth
position of the layout name.
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4.3 Modifying and updating layouts

DOCPRO includes in its scope of delivery a number of options for the adaptation of
the default layouts to your requirements:

• Replacing footers in a layout

• Editing layouts in WMF format directly in a graphic program

Replacing footers

This method is suitable if you want to use footers other than the default. In this
case, open the "Modify layout" dialog in which you can replace the footers used in
the layout with empty fields DOCPRO provides. A so-called key is assigned to
every footer. This key is used to assign object property entries when printing footer
data of the layout.

Editing layouts

You employ this method, for example, if you want to integrate your personal logo in
your hardcopy. This requires several steps:

• Export the existing layout as *.wmf file

• Edit and save the layout in a graphic program

• Import the layout in DOCPRO

Note that only the following graphic programs have been tested for editing layouts:

• Designer 4.0

• CorelDraw 7.0

• Designer 7.0

Updating layouts

In the latest versions of DOCPRO you can find corrected and new layouts. When
you open a documentation project created in an older version of DOCPRO, a
dialog automatically pops up in which you can either specify the scope of the
update or abort the update.

Use the "Edit > Layout list > Update" command to carry out a subsequent manual
update.

You must use the import function of DOCPRO to enter individual layouts.
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4.4 Rules for layout modification in graphic programs

Note the following rules when you draft your layouts:

• Draft your layout to original scale, because it is entered to scale in the graphic
program.

• The drawing frame must be a rectangular. The corners of the free drawing
frame are marked with an exclamation mark.

• Footers are identified by permanent key character strings. This is the structure
of the key character strings: $1$$$$$$$$$$#.

 Character  Meaning

$ Marks the start of the key character string

1 Key for the assignment to the footer.

$ Variable number of $ characters, identifying the footer length.

# Mark the end of the key character string

• The way you format, for example, the character font, font size and color and
the assignment to key characters in your graphic editor later determines the
print format of footer data.

• DIN standard defines the footer’s content, length and format. However, you can
freely use 10 additional footers.

4.5 Footer data

4.5.1 Footer facts

Footers represent important layout components. They contain information on the
print object and are output on every page, e. g. the page number, date of the last
change, etc.

DIN 6771 strictly specifies the footer’s position, length, presentation and content.
For example, the creating company always appears in the center of the footer
block, the page number at the bottom right etc. Ten "free" footers are available for
user-defined layouts. You also have the option of replacing existing layouts with
others more suitable to your requirements. You can also specify the footer block
information to be printed.

19.12.2001



Layout

DOCPRO Creating Documentation
4-4 A5E00134750-01

Automatic footer entries

DOCPRO automatically fills some of the footers, making it superfluous for you to
make manual entries. These footers are shown in the "properties" and "Global
configuration" dialogs on a gray background and cannot be edited. This includes,
for example, the object name and the logical path to the object. These entries are
transferred from SIMATIC Manager. The print date and page number data are also
entered automatically in the corresponding footers by DOCPRO. Print data read
out and the page number is generated via numbering configuration.

4.5.2 Valid range of footer data

Valid range of footer data:

 Footer data  Range of validity

global footer data applies to all print objects of the project

specific footer data for the
current print object

applies to all instances of the print object, that is,
if you have inserted multiple instances of OB1,
the function block is always printed with the
same footer data.

Print object-specific and global footer data

Print object-specific data are of higher priority than global footer data, that is,
DOCPRO uses object-specific data for printing if you have declared specific as well
as global footer data for a print object.

If you have defined global footer data but want to exclude them in a specific job,
enter the ~ (swung dash) character as object-specific data. In this case DOCPRO
does not make an entry in the footer.

Footer data from engineering tools

Engineering tools can transmit their own footer data at the time printing starts.
These data overwrite footer data specified in DOCPRO. For details refer to the
corresponding engineering tool manuals.

4.5.3 Footer data input

You can define object-specific footer data for all print objects. These "overwrite" the
data you have specified for the print object types.
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4.5.4 Footer editing options

You have various options of editing footers:

• for a single print object in the corresponding object properties.

• for multiple print objects via multiple selection function, that is, you highlight
multiple print objects and modify the object properties in the footer data once.

• for the print objects of a complete job list or wiring manual via export to a *.csv
file, quick editing in MS Excel and reimport to DOCPRO

4.6 Page numbering

DOCPRO offers two page numbering options:

• Consecutive page numbering – the individual pages are numbered
consecutively for the complete print job. You can also specify the start value for
the first page number.

• Page numbering within a print object – only the pages printed in the
corresponding print job are numbered. For every new print object numbering
restarts at "1".

4.7 Reference numbers

4.7.1 Reference number facts

For well arranged management of your print objects you can assign reference
numbers for unique identification. Any numbering scheme can be used for the
reference numbers. Therefore, you can customize your numbering of specific
document contents.

Generating

You have two methods of generating reference numbers:

• Automatic generation:
You must specify the numbering scheme DOCPRO will use to assign a
reference number to a print object. Thus, every object is assigned its
permanent and unique number. DOCPRO, therefore, ensures consistency of
the reference numbers.

• Manual input:
You enter a permanent reference number for every print object. However,
DOCPRO does not perform a number consistency check when you choose this
method. For this reason we recommend automatic generation of reference
numbers.

Reference numbers you specify for one print object apply to all of its instances in
the documentation.
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Delete

After you have generated them, you can delete the reference numbers.

Note

This also deletes the reference numbers you have input manually.

4.7.2 Reference number scheme

The example below highlights the principle of the reference number scheme:

Let us assume you assign print object type "CFC" the reference number scheme
"AB-??-CD" the start value 1 and increment value 1. In this case, the first diagram
in your documentation is assigned reference number "AB-01-CD", the second is
"AB-02-CD" etc.
Multiple instances of the same print object entered are assigned the same
reference number.

Note

You must define an individual reference number scheme for each one of the print
objects in order to avoid identical reference numbers.

When do I have to regenerate the reference numbers?

 If you…  … then

have defined a new reference number scheme
for a print object type,

you must generate new reference numbers.

have modified an existing reference number
scheme,

you must first delete all reference numbers
and then generate new ones.

Caution:This also deletes the reference
numbers you have input manually.

have inserted a new print object, you must generate new reference numbers.

if you have inserted another instance of an
existing print object,

this instance is automatically assigned the
corresponding reference number.
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4.7.3 Reference number scheme – Start and increment value

You must take two additional parameters into account when you define a reference
number scheme, namely the start and increment values. Here the following context
applies:

For example, the scheme be : A1000-B200?-C3??-D01

Three ’?’ are defined in this scheme, that is, you can specify consecutive
numbering for up to 1,000 different print objects.

The sample calculation in the table below highlights the effect of start and
increment values on the maximum number of print objects:

 If the start value is  and the increment value is  the maximum number of print objects is

= 0 = 1 = 1,000

= 900 = 1 = 100

= 900 > 49 = 2

This general formula applies:

( ) valueincrementvaluestartingobjectsprintofnumberMax number /10. ? −=
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5 Print

5.1 Printing function facts

DOCPRO printing functions offer you a number of solutions:

• Printing of the complete documentation or parts thereof

• A print preview of individual print objects

• Printing of a document directory

• Printing to file

Prerequisites

Before you initiate a print job, you must

• install a printer on your computer or network,

• install a printer driver via Windows Install program or Control Panel. For
information refer to your Windows documentation.

5.2 Displaying the print preview

You can display a print image on-screen before you initiate a print job for a specific
print object. Thus, DOCPRO offers you abundant controlling options. You can use
the "Zoom" and "Zoom out" buttons in the print preview to customize the size of
your print preview. Close the window with "Close" to return to DOCPRO.

5.3 Print job

A print job is a dynamic object: The print job is formed by this object, or by the ones
you select for printing from your documentation structure. You can print your
complete documentation as well as parts thereof, for example, one or multiple
wiring manuals, job lists or print objects.

Multiple selection forms a highly flexible function for processing your
documentation: In the detail window you can highlight all objects you want to print.
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5.4 Print to file

Prerequisite for preparing your online documentation in PDF format is that you print
your documentation to a file.

This procedure is basically the same as for direct output to a printer: Highlight the
object you want to print and then output the print to a file by marking the
corresponding checkbox in the "Print" dialog.

Note

Note that you must select a post script printer. Otherwise, you cannot generate a
pdf file from your print file.

In the "Print" dialog you also specify the home directory for your print files. The
print file name extension is "prn".

Naming the print files

Print files are named under the following principle:

 Objects  Name of the print file

Print objects • DP(consecutive number).prn or

• Object name(consecutive number).prn

The file name corresponds with the object name, if the application you
have used to create the object supports the assignment of object names.
Otherwise, the general name "DP" is used to name the print object.

Cover sheet Cover sheet (consecutive number).prn

Object document
directory in the
directory window

• Unterlagenverzeichnis_Auftragsliste.prn

• Unterlagenverzeichnis_Schaltbuch.prn

• Unterlagenverzeichnis_Dokumentation.prn

Filing

Every print object is printed to its own print file. File your print jobs in separate
directories. Otherwise, starting at "1", every print job increments the print file
number and overwrites existing print files without confirmation.
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5.5 Printing the document directory

The document directory is a table listing all print objects belonging to a print job. It
is an image of the print queue.

A document directory is output

• at the end of a print job – provided you have enabled this function – or

• individually in a separate print job.

5.6 Interrupting and resuming the print job

The type of output medium as well as the job volume makes printing of a system
documentation a somewhat slow process. In some situations it might therefore be
required to cancel the print process. In DOCPRO you can resume an interrupted
print job.
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6 Reference

6.1 Meaning of layout names

The name of every layout indicates specific information. The meaning of the name
characters is found in the table below.

 <ordinal number>  Meaning

1,2,3: Format:
A3_: DIN A3
A4_: DIN A4
L11: Letter
L14: Legal

4: Orientation:
’P’: portrait
’L’: landscape

5: ’C’: Cover sheet
’_’: No cover sheet
’K’: Layout for continuous page numbering
’7’: New layouts in DOCPRO Version 5.1

6: Position of the footer block:
’B’: bottom (at the lower margin)
’_’: No footer block

7: Position of the binding margin:
’T’: top (upper margin)
’L’: left (left margin)
’_’: No binding margin

8: Language version:
’A’: German
’B’: English
’C’: French
’D’: Spanish
’E’: Italian

Example

 Layout name  Layout appearance

a3_l_b_a: Original DIN A3 format, corresponding precisely with DIN 6771.
a3_l_b_b: DIN A3 landscape, bottom footer, no binding margin, English
a3_lc__b: Cover sheet DIN A3 landscape, no footer block, no binding margin, English
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6.2 Footers

6.2.1 Meaning of footers

The table  shows you details on the position, length, content and meaning of the
footers defined in DIN 6771. Font size for all footers is 10 pt.

$20$$$#

Zustand
$18$$$#

$19$$$#

$23$$$$$#

 Änderung
$21$$$$$#

$22$$$$$#

$26$$$$#

$25$$$$#

$24$$$$#
Datum

$29$#

$28$#

$27$#
Name

Datum

Bearb.

Gepr.
Norm

$10$$$$$$$$$$$#

$11$$$$$$$$$$$#

$12$$$$$$$$$$$#
$13$$$$$$$$$$$#

$3$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#
$4$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#

$5$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#

$53$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#

$31$$$$$$$$$$$#

$32$$$$$$$$$$$#

$1$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#
$2$$$$$$$$$$$$$$$$$$$$$$$$$$$$$#

Blatt: $17$$$$$$$$$$#

$6$$$$$$$$$$$$$$$$$$$$$$$$#
$7$$$$$$$$$$$$$$$$$$$$$$$$#
$8$$$$$$$$$$$$$$$$$$$$$$$$#

$54$$$$$$$$$$$$$$$$$$$$$#

$16$$$$$$$$$$$$$$$$$$$$$$$$#

$58$$$$$$$$# $9$$$$$$$$$$$$$$$$$$$$$$$$$#

=
+

! !

$33$$$$$$$$$$$$$$$$$$$$$#©

$56$$$$$$$$$$$$$$$$$#

$57$$$$$$$$$$$$$$$$$# Seite: $50$$$$$$$$$$#

 Key  Field name  Number of
characters

 Meaning

$1 System identifier block
(SID)

32 Equipment identifier (System ID)

$2 Location identifier block
(LID)

32 Equipment identifier (Location ID)

$3 Customer 32 Customer ordering the system

$4 Operator 32 System operator

$5 System 32 System type

$6

$7

$8

Description 1st line

Description 2nd line

Description 3rd line

27

27

27

Description of item displayed and, if
required, additional information

$9 Document type 27 Type of technical document ( e. g. symbol
table)

$10 Date of creation 15 Date of document creation

$11 Editor 15 Name of the author

$12 Verified 15 Name of person who has verified the
document

$13 Standard 15 Standard by which the document was
created

$14 Special comment 12 Special notes on the document

$15 Document number 28 Document ID assigned by the author

$16 Reference number 28 Document ID assigned by the customer

$17 Sheet number 6 Number of the printed page

$18 1st modification:

Modification index

7 Modification ID
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 Key  Field name  Number of
characters

 Meaning

$19 2nd modification:

Modification index

7 see above

$20 3rd modification:

Modification index

7 see above

$21 1st modification:

Comment on the
modification

9 Comment on the modification

$22 2nd modification:

Comment on the
modification

9 see above

$23 3rd modification:

Comment on the
modification

9 see above

$24 1st modification:

Date when modified

8 Date of modification

$25 2nd modification:

Date when modified

8 see above

$26 3rd modification:

Date when modified

8 see above

$27 1st modification

Name of editor

5 Name of the editor who has carried out the
modification

$28 2nd modification

Name of editor

5 see above

$29 3rd modification:

Name of editor

5 see above

$30 Number of original
diagram

49 Number of the source document

$31

$32

Created by 1

Created by 2

15

15

Name of the company that created the
system

$33 Company, Year 25 Information that is to appear in the
Copyright– note

$34 Document type 24 Type of document

$35 System part 24 System part

$40 to $49 Free fields 40 Fields available for text entries

$50 Consecutive page
number

12 Page number, if consecutive page
numbering is set – applies only to layouts
with consecutive page numbering

$51 Date printed 15 Date at which the print job was executed –
applies only to layouts with consecutive
page numbering
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 Key  Field name  Number of
characters

 Meaning

$52 Time of print 16 Time-of-day at which the print job was
executed – applies only to layouts with
consecutive page numbering

$53 Project path 49 Object path in SIMATIC Manager – applies
only to layouts with consecutive page
numbering

$54 Object name 24 Name of the print object – applies only to
layouts with consecutive page numbering

$55 Author of the object 25  – automatically filled

$56 Object creation 21 Date/time-of-day – automatically filled

$57 Object modification 21 Date/time-of-day – automatically filled

$58 1st network on page 21 – automatically filled

$59 Symbolic name 40 Symbolic object name – automatically filled

$60 Object comment 24
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6.2.2 Footers to DIN 6771

The sketch shows you the basic arrangement of a footer according to DIN 6771.
The arrangement of the individual footers is not drawn to scale.

6WDWH &KDQJH 6WDQGDUG

&KHFNHG

$XWKRU

'DWH

6KHHW

'DWH 6KHHW

12

1DPH

13 14 15 6
7

3 16 17 4 10 9
8

1 2 115
18

Meaning of the specific footers

 Number  Meaning

1 System identifier block

2 Location identifier block

3 Customer, operator, system

4 Designation

5 Document type

6 Editor, tested, standards

7 Date of creation

8 Special comment

9 Document number

10 Customer’s drawing number

11 Sheet no.

12 Status: Modification index

13 Comment on the modification

14 Date when modified

15 Name of the editor who has carried out the modification

16 Number of original diagram

17 Creating company

18 Company, Year
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6.2.3 Example of footers for a cover sheet

The cover sheets included in the scope of delivery offer the following footers:

6.2.4 Example of printing reference data

Printing reference data with the "Cross-reference" view:
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6.2.5 Example of printing a symbol table

Printing the symbol table with the sorting criteria "Ascending symbols" and the filter
setting "all filters":
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6.2.6 Example of printing blocks

Printing OB35 in symbolic presentation
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Printing the FB61 block in symbolic presentation
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6.3 Symbols

6.3.1 Facts about icons

DOCPRO provides various symbols:

• Toolbar icons

• Directory structure icons

6.3.2 Toolbar icons

You can quickly execute some of the menu commands with the help of the toolbar
icons.

 Icon  Function

 
New - File menu

 
Open - File menu

 
Print - File menu

 
Cut - Edit menu

 
Copy - Edit menu

 
Insert - Edit menu

 
Context help - Help menu

Note

Select menu item View > Toolbar to show or hide the toolbar icons.

6.3.3 Directory structure icons

Objects in the directory structure are represented by the following icons:

 Icon  Object

 
File

 
Wiring manual

 
Job list

 
Cover sheet

 
Job for an object that does not exist anymore in SIMATIC Manager
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Glossary

CSV file

In CSV format files data columns are separated by delimiters and all data lines are
concluded with a line feed. In cells containing a delimiter the contents of each table
cell is enclosed in quotation marks.

CSV can be opened and edited in programs such as MS Excel.

Detail window

Here you are shown details on specific print objects, e. g. the object path, object
name or the symbolic name.

Directory window

This shows the hierarchy structure of the documentation. The directory window is
part of the DOCPRO user interface.

Documentation

The "Documentation" folder in the directory window contains all descriptive system
data. The folder can contain one or more wiring manuals which are further
subdivided into project data.

Document number

ID for the documentation or parts thereof, assigned by the system owner.

File directory

A listing of all printed print objects, sorted to their physical print queue sequence. It
contains information in detail.

Footer

Every Layout conforming to standards contains a footer block that is output on the
page margin. The footer contains information on the current print job, e. g. the
document type, date of last change and page numbers.

19.12.2001



Glossary

DOCPRO Creating Documentation
Glossary-2 A5E00134750-01

DOCPRO automatically determines some of the footer information, e. g. the page
number. Other information is user-specific.

Job list

Job lists are objects containing the specific print objects. Print objects are sorted in
the job lists according to freely selectable criteria.

Key

Every footer principally used in DOCPRO is linked to a specific key to establish a
definite correlation between specific layouts and input fields.

Layout

The layout determines the print image of a job. The layout defines, for example, the
page format, alignment and arrangement of the printed page as well as the footers.

Multiple selection

With the multiple selection method you select a number of print objects you want to
configure in a single batch operation.

PDF file

The PDF file format can be read with a freely available software, the Acrobat
Reader. PDF files can only be post-processed with a licensed version of Adobe
Acrobat.

Print file

The print file can be recognized on its "prn" filename extension. A print file is
generated if the file is not output directly on a printer, but rather initially redirected
to a file. In the next step this print file can be used to generate pdf files.

Print job

Print jobs are variable: Objects selected for printing in the directory window form a
print job. It is also possible to generate print jobs for single print objects. Print
objects are of temporary nature.

Print object

Print objects are all printable objects of a STEP 7 database. They can be viewed in
the DOCPRO detail window. Print objects are instances of print object types.
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Print object type

Every print object can be assigned to a specific print object type.

Reference number

Freely definable sorting criterion for the organization of specific jobs. Usually the
customer assigns these reference numbers. In DOCPRO you can enter the
reference numbers manually or generate them automatically.

Reference number scheme

When reference numbers are automatically generated, the user can assign a
customized reference number scheme to individual print object types.

Report

This protocol contains information on specific operations carried out in DOCPRO:

• Execute print job

• Footer data import error

View

In DOCPRO you can define different views for specific print objects in order to
obtain different information.

View

Some applications display their data in different views, e. g. you can print the
blocks with their symbol information, with comments and information on cross
references.

Wiring manual

A documentation can consist of one or multiple wiring manuals. Wiring manuals are
used to organize project data. Wiring manual data are filed in job lists.

User interface

The DOCPRO user interface is split into two sections: The directory window and
the detail window.
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